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AT AAEY OBSHT

AK~P—AR— RiZ, 4GB T TORAEVILEY A X 52>, VoV )V/F 2T /LF ¥ %/ DDR

400/333/200 A EVE 2 —/LHIZ, 450 184 £ DDR DIMM % 7 v k22t U £,

£2-1. AEVEREDOH

Nz AEYET2—L =t
Bank 0, 1 (DIMM1) 128, 256, 512MB, 1GB 128MB ~ 1GB
Bank 2, 3 (DIMM2) 128,256, 512MB, 1GB 128MB ~ 1GB
Bank 4, 5 (DIMM2) 128,256, 512MB, 1GB 128MB ~ 1GB
Bank 6, 7 (DIMM2) 128,256, 512MB, 1GB 128MB ~ 1GB

VAT ARAEY OEF 128MB ~ 4GB

7 2-2. AMD939 ' 7t v Y DHIZFHE/Ny 7 7 DIMM Y R— b

7;;? DIMM1 DIMM2 DIMM3 DIMM4 DRAM HFE
1T 2T

SVINT Y N/A 78 N/A DDR400 | DDR400
BTNT T N/A 7 N/A DDR400 DDR400
64t % N/A eTNT N/A DDR333 | DDR333
]/7(; e N/A TINT N/A DDR400 | DDR400
Fo |YYINTY N/A YINT N/A DDR333 | DDR400
) v sy N/A FINTG v N/A DDR200 | DDRA400
BINT s N/A TTNT N/A DDR200 | DDRA400
BTNG oy N/A FINTG v N/A DDR200 | DDR333
SUING Uy |V TNT 2z 7z DDR400 | DDRA400
ETNTG T |\ FTNT s 7 7 DDR400 DDR400
1385 7z 7z Y INT | 77| DDR333 | DDR333
(= 2z 7z FTNTY | #FNF s | DDR400 | DDR400
7»? US|\ INT | I T [ VT | DDR333 DDR400
*7/;7\ SYINTG ey |V ITNT N FTNT | T 5 | DDR200 | DDR400
BING vy | BTNFey | Y TNT | 7T DDR200 | DDR400
BING oy | FTNG ey | FTNT Y | #7057 | DDR200 | DDR333
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7 27 /LT ¥ %)L DDR OHEREEGHITIE, WOBINIHE S RERH Y £7,
2 20 DIMM EV=2—)VEBRY 75 L &: A v FDIMMIHDIMM2] £ 72 A 8 v K
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[DIMM3]+[DIMM4]iZ%f L TR L & A 7 & A XD DIMM E ¥ = — /L&) ({1 £,
©

FEAFVEY 22— VEROATZD, VALY L2k, N"—FU7=7BIOS v h7
v 7T OMETH Y AN, AHMECET ARENE CESEAIRET CMOS AE U ZHELT
LTEEW,

AEVEY 2= VOB TN LETORNT, 2o Ea—XOER A 72T AC B

a— REHRNTL 70,

1. R—FODIMM 2u vy FE¥ELET,

2. DIMM EVa—/LOaxr ZZfilis 720
LN E, ZOMMEEZE > LD
F9,

3. EVa— VD) yFFXx—% Ay bDY
TR bEET,

4. FEVa— EATy MILoMNY gL
Zv -y NOWRIOA V=7 2% TR
3037 v FICHTF v EFELTTHEHN
WHEEESNET, DIMM £V 2 — /i ZE LA E ZCEEAR 2 ANV T ZE N,
DIMM & ¥ 2 —/LiZ—FHEIZET 7 4 v b TDHE 9128 >T0nET,

5. DIMM &V a2 —/LZRVHATIZIE, Ary bD22DA T =7 ¥ 2T % [FERHCIMINZIR LT
75, DIMM £ =2 —/L&2 0 HLET,

BEE BEIIa L P2 — 2 DEI IV R—R Yy hRA T2 a v OR— RERET 280035 0

F9, TNOOFIEZFET AR, T—AIhi-&RWEICER filh s Z & T, HEXEfMHEE

WICHEL T EE,

Mounting Notch Notch Key

Ejector Tab

184-pin DDR DIMM
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ZIVPCIE 75 7 4 v 27 Ji— RH) 3L CrossFire £— F (CrossFire" Edition 75 7 4 v 7 71
— R 1 #3 L CrossFire” H#7' T 7 v 7 —F1HH) .

¥E: ATI CrossFire” 77 / B —(%, BfE, Windows XP —E 27 2 AL —F 4 7
AT LDIIHKIE L TWET,

CrossFire
Compatible
Graphics Card

#18{7- Shadow Card £ D::
ol q I:i

PCIEXP1

CrossFire
Edition
3B Graphics Card

) PCIE
\J Graphics Card

U

/) —=<)VE— F:PCIEXP2 (¥ A% —) %
my NI PCIE V974 v 71— R,
PCIEXPl (AL —7) RZnm v MI ABIT
Shadow 7 — &AL E£7,

CrossFire =— F : PCIEXP2 (¥ A% —)
A1 BT CrossFire” Edition 77 7 4
v 7 71— R% 1 . PCIEXP1 (AL —7)
A1y NI CrossFire” BT T 7 4 w0
—R& 1R ALET,
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2. PCIEXPl (AL —7) Zum v NI ABIT
Shadow #— RZ&HfiAT 5,

3. PCIEXP2 (v A% —) Zu v MZI PCIE
TT7T7 47— REHAT D,

¥£: ABIT Shadow % — K& PCIEXP1 (A
L—>7) Ay MIFEAL, #xhics 77«
v I H— REFFALRNTL I,
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(2). SLI €E—F:

CrossFire & — F& AT DI, WOFIHEIT> T EE W,
. CrossFire" Edition ' 7 7 « v 7 17— R % 1 ¥, 33 L O CrossFire” HAT T 7 4 v 71—

Rz IRHELET,

. 757 47— K RFTA 30 ATI CrossFire™ 77 / b V—Zx i LTW5A Z & R
LTLEEN, mHFTA2NL, ATIHO Y = 7 A b (www.ati.com) TH 7 > a— KT

TET,

o  Elm=v M, REXNEESNDENEZMET DOITHLSNE O PHERB L TIEE N,

1. rossFire & — K% A %0123 2 120%.
CrossFire" Edition ATI ' 7 4 v 7 51— K
21 B L) £9, (4 : CrossFire”
Editon 7'F 7 4 v 7 H— DT Z /v MM
1%, #3172 CrossFire” DMS-59" =t %7 & 3
I TnEd, )

2. AAVAR—F®DPCIEXP2 (v A% —) %
w1 MZ, CrossFire" Edition 77 7 ( v 7
N—REBALET,

3. AL —7 A1y ML, CrossFire” H.#a
PCI Express 77 7 4 v 7 71— R 1 Al
LRVES, FE:AL—THA—FDT T
4 v MZIX CrossFire” DMS-59" =237 %
NEFINTOHETEA, )

4 PCIEXPI (AL —7) Anu v ki,
CrossFire" At PCI Express 77 7 4 v 7
H— REFHALET,
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5. DMS-59™ axo X%, NRur—UIlE 8. 7¥—7 )LD DVl A Aax7 % L&,
FNAMESER T — 7 VR E L £, CrossFire" H.#4 PCI Express 77 7 4 > 7 7

— RO DVI-I 237 Z &8 LET, KRIZ,
r—TND DVIL A AR ZEET=F|T
B LET,

6. DMS-59" M A3 — 7 ML, EXD
ko3 ooaxsanbn iy, axs
A 11X DMS-59™ A RAax /7 X axy X2
IZDVII A RAax7 % ax7 % 31LDVI
FARaxy & L0 ET,

7. 7 —7/N®D DMS-59" A Raxs L,
CrossFire" Editon 75 7 4 v 7 B — KD
DMS-59" a7 Z ZHH LET,
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2-5. axXgE ~y AT

ZIWE, axg B~y ALy TF L FOERFTENRETERINTNET, 20 Ba—
HDYr—YMNIZETON— R =7 20 1T 2801, & CTOHEEF A CTUERIEREZFHICA
NTLEE, BROV-ODIZ, R— R EOaxy # L~y ZOETOMMBIZRIET D 52aRiik
MERZS 1 EIRLUET,

B IR VIR — 3 v R A BN L2 Y BD SRS, AZW’”:!‘/E:—ﬁ@%?E%z“W:
LB, ACTHETEDT T 7T HKNTLIZE, SHRTFIE, v —R— RIS
BEABREEZZ YLV ET, 2 TEHDICTF=v 7 L%k T, ACF YE:“—F@T'J
THZLIANLTLEE,

). ATXEBFEAHIXIZ
ZOY—R—=KI2 >OEF 237 ¥ 24t LT ATXI2V BFEEICHERE LT,

E:ID24 BVUERaRsZ “ATXPWRI” [EIH 20 B2 Z A ZITHIELTWET, Z D,
EUOHFMICEELTLEEW (B 11, 12, 23, 24 1 TREGOEE L0 F3) .

=, © ©

1
GND—fe](a}— GND
+12v —felleh— +12v

24 12
ATX12V1 ATXPWR1

JATXPWR1

& AMOEVWS ZAT LAOEEIE, 7R &b 350W, 20A +5VDC BED, FEONE Z LiEREE
P R— b T 25413, 27 L LB 2A +5VSB FEOEFEREICER TS L O ICBEO LET,

12V fiBhEER O * 7 % [ATX4P1] 7 PCI Express A0 v MIEMENizT
NT ZADEDISEIEREZMIE. ¥ 27 AORELEZEZE L. BEID
ATX4PT 12V BFERRT 2 LR LE T,
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(2. FAN ax27 %

ML AR ZFTENTENT AT AL VA =NV ENTZ7 =Y T 77 CEREHG L
7

CPUFAN1 : CPU 7 7 &

SYSFAN1 : ¥ AF L7 7 v

NBFAN1: v 7ty b7 7

AUXFAN1, AUXFAN2, AUXFAN3 : B~ 7

B TNOEDT 7 ar g Iy R TEH Y EFRA, TRHEDART HIIT Ty

GND
+12V
SENSOR
FAN

(3). GURU 7 v ZEE~v ¥
~v 1% ABIT OEH GURU 7 1 v 745kt & 5 IR S TWVWET,

©

OTES

ST
idiiiiiiii

SILENT

T 4
GURU1
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4. CMOS AEY I YT YV T~ H

Z D CCMOSI ~y IV ¥ 3% v v 7HFHL T, CMOS AEV ZHELET,
Br12va—b (FT740b) : EAERE

By 2-33a—b :CMOS A€ Y DHE,

H:CMOS AEV A7 UV —=V 7 FHHNIT, £THSV RAZ UL BRZED)ERE A 71T L
TLIEZEW, SHRTFIUL VAT AR REREMEL I & L0 &9 2 mRetEn d v £9,

© = © ©

Normal
(Default)
321
Clear CMOS

321
CCMOs1

5). ABA—T 1 AaRr ¥
B0 axy ZiL, NEECD-ROM K74 7 £72137 KA — ROA—F ¢ AH I EH#H L
£,

© €
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(6). HIEI/SRNVDAL v F LA 2 Vhr—5 B

TNy ZNE, AL v FELED A ¥ —F &L — VRISV ERE T DO S
e I8

IR LED O B UNLE & FIIZIEL TSN, FRIOE A~ EARZT A TN DD~ —27 1%,
LED ¥#iD 77 AR LET, INHO~y XIZHEWR R L TS 7ESW, Fzific
BEfi L CH LED BT LAaWIEIT D Z E TR, A v FOMES Im#ERUT S AT AOMEED
JRINERDZ End £,

OTES

SILENT

SLED PWR PLED

-1 1 ~ 1
2 20
1 19

| I [

HLED RST SPKR
FPIO1

RST (5, 7)
VY —VHIEASRNADY By AL v F =TI L E T,

SPKR (¥°» 13, 15, 17, 19)

VX =V DYVAT LA == —T T LT,

SLED (¥ 2, 4)

VX — VRIS RV DY A R LED 7—7 /v (b L) 8k L ¥,
PWR (E°> 6. 8)

vy —v7uy MRV OERAA v F =T BRI LE T,

PLED (¥ 16, 18. 20)

vy —v7nuy bRV OERLED 7 — 7 MCHERELE T,
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N V=0T vT~v¥

USB-PWR2

)

USB-PWR1

3 (m 3@

2g 20

10 1 [m]
Disabled Enabled
(Default)

USB-PWR1~2
FP-PWR1

USB-PWR1 :

Er123va—bh:USBIAR—bhCTOT =77 v THEEOTR— 2B LET,

vr23va—hk (F744K) (USBIAR—hTOYV—2 7T v 7HEEOTR— v EZHMTL

EE
USB-PWR?2 :

B 123 a—h i USB2R—FTOU=—27 7 v e BN LET,

Br23va—bh (F7x0h) (USB2R—bhTOU=2—7 7 v THEEERDNCLET,

FP-PWR1 :

v 1-2 33— b : FP-USBI, FP-USB2 R— F TO T =— 27 7 v FHEREZ AN L £ 9,

vy 233 a—hk (F74/ k) :FP-USBL,FP-USB2 R— R TD Y =— 2 7 v FHEREZ NI

L%,
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Q). ZRyVE—LIDET 4RI RFALTaxI 4

©)

OTES

ST
T

SILENT

IDE1

IDE2

1

%
%

FDC1

FDCl a7 X334 VA Y 2axr 270y = —7 L TRRK2OO72y E— I T%
BT N TEET, VR —TADOEVWHICHD 1 DD a Ry Z & R— KO FDCI 1T
L, bIORFO2o0axs %70y =T 4 A7 RTA4TIZERHEL T ESW, #F, &
AT AIRER Ty =T 4 A7 T4 7131 27 TY,

E: VAR —TNLDORVEIEIFDCI AR— & 7 a vy E—aRx 7 ZOWFDO L 1 IZEbYE 5%
ERH Y ET,

%A IDE AR— hax 7 #2140 B2 80 A F 7 4|

Master Drive

3 a3k Z® Ultra ATA/66 VR r—T7 L&~ T Black Connector
Ultra ATA/100 E— R TR K2 2D IDE KT A 7 %% 40-pin IDE piug
flf}%@— HZ & NT % i TO on the motherboard

Blue Connector
VR =T VOREWEON (FWaxr4) 220
R— RO IDE AN — MIHERE L, W OHHIAF Nz 2
OODaARTH (KELBoaxs ¥y Z—FKRJ4
TOaxy ZITHEE LT T80, Slave Drive
Gray Connector

H: VAR —T N T2o0D K747 Z8Hid HRIIC, "Master" & "Slave" BIfRZREL T 72
EV, VR =T A DOFRVERL IDE R—hEN— R KIA4 T axs ZOlFOE . 1 I2h&b
TLEMERDH Y F9,

Z—PF—r=2 T
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9). YUTNVATA X7 &

NSO Zix, Serial ATA 47— 7 UEH TKF ¥ RAVFIC 1 DD Serial ATA F /351 A%
B A DICHE SN TWET,
=, © ©

u

o
-]

<3
o
<
e
<
=

@
]

SATA1

ATA2
SATA3
SATA4

=)
—

(10). RF—F AL VT —H

S5VSB: Z® LED I, EHREEBNERICHEFR SN TND EEITAITLET,

VCC: ZDLED X, VAT LAOBRENA N/ TND EXITHITLET,

LED1: Z® LED &, PCIEXP1 At NI T7 4 v 27— RKPHASHTOBEAITAIT L
9,

LED2: Z® LED I%, PCIEXP2 A0 > NIV T 7 4 v 7 I— RBRHASNNTWDELAITAIT L
E9,

LED3: / —~ /2757 v 7 F—RTYVATLANEEL TWAKRIZIL, 20 LED 28,84 LEd,

()

|
OTES
RAREREERRRET]

SILENT

vee
L BysB Ve

ATS8
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(11). PCI Express x1 22 > b

hbozRn sy M, RO VO 7T —%7 7 F v AT,
[~]© =, @ ©

(12). PCI Express x16 A 2 v b

Zo2Any MI, WHROZ T 7 (v 27 « T=%7 7 F ¥ T,

PCIEXP1

Z—PF—r=2 T
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(13). B0 USB R— h~v &

INHED~y ZiFENE N, USB 2.0 LA L Tk &N/ USB ¥ —7 L &i@ L T, 2 DDA
JNUSB 2.0 A— M a4t L E 7,

7531
1086 42
FP-USB1~2
(= FY YT = NG

1 VCC 2 vCC
3 Data0 - 4 Datal -
5 Data0 + 6 Datal +
7 T —A 8 T—A
9 NC 10 NC

(14). JBA0 IEEE1394 R— b~ &

INBDO~Ny ZXENEN, EEF—TNVET Ty FEELT, 1 DO IEEE1394 AR— k

BEREAHRAE L E T
[-]© 2 0© ©

Ol
e 7531
- AHHEH
10864 2
FP-1394-1
B Ve B ElD 2T
1 TPAO + 2 TPAO -
3 T —A 4 7=
5 TPBO + 6 TPBO -
7 +12V 8 +12V
9 NC 10 T —A

ATS8
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(15). i SRNVDA—F 4 A8~ &

IO~y HIE, 7ay MRV TOLE—T 4 A axy Z IR L £,

BT SRV CTA—T 4 FaRx 7 ZEHATHI2E, 2O~y FOFTXTOT ¥ L 3F R 4L,
¥y — VBT BIER s — TV CRITE SR VI EERE L £ T,

TR/ NNV TE—T 4 A ax 7 Z AT I, EEFr—7 0 E2E, B2 56, BLUOEY
9-10 DV ¥ U NETTICR LET (F 74V hMEE) o

= En YT =gV ED 2T
9 46810 1 |MIC2L 2 |AGND
EB‘ . ! " 3 |MIC2R 4 |Avce
n | |
135709 5 |FRO-R 6  |MIC2 ID
FP-AUDIO1 7 |F_I0 SEN 8 |NC
9  [FRO-L 10 |LINE2 JD

Z—PF—r=2 T
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(16). Tt/ SRV DEEE

LAN1
Mouse

SL/SR| | Mein IEEE1

©
[+X:]

I_II_I.
| @O O

[ | | Cen/Sub| |LineOut

[y
IIE

Keyboard OPT-IN1 OPT-OUT1 AUDIO1 AUDIO2 USBE1 USBE2

Mouse : PS/2 v 7 A L 7,
Keyboard : PS/2 ¥ —AR— NIZHHE LE T,

OPT-IN1: ZDOax 7 XL, 77 A NRNEBBLTCT VXL IVTF AT 4 T T34 A~D S/PDIF
A R R L T,

OPT-OUTL: ZDa Xy I 7 7 A REBLTT VHIN~INTF AT 4 T T /3 Z~0 S/PDIF
7 U MNER ARt L E T,

AUDIOL1 :
SL/SR. (W FD Vv REMNTFIVFER) BT NELH T UV RET Y R E 11 T v
VRNKE =T 4 AV AT DITHEE L TL &,

RL/RR. (FEE /| HFEAE) : 7.1 F ¥ FNADOL—F 4 VAT AOFHEAER L OHAT ¥ 3
INZHEHRE LET,

Cen./Sub. (v & — | Y70 —T%) 171 F ¥ XNDE =T 4 AV AT 2DV X —BLOY
T =T 7 F v VTR L E T,

AUDIO2 :

Mic-In : M~ A 7B 7T TR LET,

Line-In : A —F 4 T —ANS T A T MO L E3,

Line-Out : 7.1 % RV ETFBEFH D 2 T ¥ VA —T 4 T AT AORIEE & #iifif T v 1L
WCERELE T,

IEEE1 : IEEE1394 7’1 b 2L DF S8 R THe L £,
LANI1 : {3 (LAN) (286 L £,

USBI/USB2 : AX ¥}, TUHNAE—N— E=HF ~TJA F—FKR—F, N7 FTIHIL
HAT, VaAf AT 477 EDUSB T /31 AN LE T,

ATS8
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# 32 BIOS IZDOWT

ZO=YW—R—RNEF /T LA[FEZ EEPROM ZEfit L, BIOS =2 —TF7 4 U T 4 2 HHT5HZ
ERTEET, BIOS EAAL T AT ) E7 0t w4 L ENEBOR TRIEDEARL L%
WS 2707 T A5 TT, ~P—R—FEROMIT7Z0, VAT LEFEHER LY, “Ey b7
v T OFEITHFRTHEXIZET, BIOS By N 77 a s I awRALEST, KAETIE,
BIOS2—7 4 UT 4Dty N7 v 7a—T 4 UT s 3B LET,

VAT LADERE AT B E, BIOS A v —UNBMEICFIRSN, AT YNL T NEBEEG
L., KORA vy e—UBNHHEICERINET,

PRESS DEL TO ENTER SETUP

AT AHNCA v E—U BT 5. <Ctrl> + <Alt> + <Del>F —Z#37y, v Ba—F v —
POV hREZVEMLTAT LAZHEZEILET, ZNH0 2 DOFENKRBLESEA DA,
EBFEAFT I LB ELA VT LTV AT AZHENTAZ N TEET,

Del>F—ZM L7172, AV A= a—BEARRSINET,

Phoenix - AwardBIOS CMOS Setup Utility
» pGuru Utility » PnP/PCI Configurations
» Standard CMOS Features Load Fail-Safe Defaults
» Advanced BIOS Features Load Optimized Defaults
» Advanced Chipset Features Set Password
» Integrated Peripherals Save & Exit Setup
» Power Management Setup Exit Without Saving
Esc : Quit T ] = < : Select Item
F10 : Save & Exit Setup
F6 : Save PROFILE to BIOS F7 : Load PROFILE to BIOS

Change CPU’s Clock & Voltage

B VAT AOREMEEREEZED D20, BrEOHGE BIOS A == —Z#ix ek LT
WE$, BIOS Y b7 v 7 & AE TR LEZHHIZZBOZDDO O T, BEIiZFERENS
HDEERIH LRI EHEHY T,

Z—PF—r=2 T
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BIOSty N7 v AL v A=a—|2iF, BEOA TV a vRnFrdsnEd, KAZEOLTON—
VTCINLDAT v a v ERAT vy TN ATy TR LETN, 2 2 THAT 2HiRF—ICo
W, EPMBICTHAWVWEZLET,

Esc:
ZORE U ETE, BIOSt Y FT vy T EKTLET,

1 |-t

AAVAZa—TINLORY U EHT L, RELIMEET LA T a Vv EBRTEET,

F10:
BIOS T A =4 D&y NT v TNET Lizh, ZORYUVEHLTI HNDNRT A—F EARTF
L. BIOSty N7 v T A=a—%2KTLET,

Fo:
BEOHREETa 77 ANVELTREFELET,

F7:
iR E L7 7 m 7 7 A Vv — RLET,

ATS8
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3-1. pGuru Utility

SoftMenu = —7 4 U 7 41X, CPU OBERE T 1 7T A9 572D ABIT O EHITIEMD
)1~ya v CT¥, CPUFSB#E, vV F 774 Y 7774, AGP&PClZ/uv2 CPU=T
T AETONRTIA—F TV X T CHEIETHZ LR TEXET,

OC Guru:
pGuru Utility Vv1.00
[OC Guru [ABIT EQ
AMD Athlon(tm) 64 X2 Dual Core Processor 4200+ Item Help
Frequency: 2200MHz
CPU Operating Speed 2200 (200)
X - Multiplier Factor x11.0
X - External Clock AUTO
- Estimated New CUP Clock 2200MHz
X - PCIE Clock 100 MHz
Voltages Control Auto Detect
X CPU Voltage 1.3500v
X - NB 1.8V Voltage 1.80 v
X - DDR Voltage 2.60 Vv
X - HyperTransport Voltage 1.20 v
X - NB 1.2V Voltage 1.20 v
X - DDR Reference Voltage Default
» Power Cycle Statistics Press Enter
7 | :Move Enter:Select +/-/PU/PD:Value F8: On The Fly F10:Save ESC:Exit

AMD Athlon(tm) 64 X2 Dual Core Processor 4200+

ZDT AT AIECPUDET VA,

Frequency:
ZDT AT HIECPU OWNE Y vy 7 HELZRRLET,

CPU Operating Speed:

ZDT AT HE, BFEND CPU DK A 7 LHEEIZHES T CPUDARL—T 4 VI HEAZFRL
F 9, [User Define] (=—V—7EFK) 47 v a v a2@®INTLHE, ~=aT7 VAT a it AbI L
NTEET,

Z—PF—r=2 T
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User Define:

B yny 7 BRI 0y s ODREEEDE . CPUEFA—V2EZ2 52 L0800 £,
PCIOF v 7y hERiF7T oty POAHEL ) bRWVERICHET D& AT EVa—L
TT— VATAITvva, N—RFT A4 AT RITALTDOTF—Fuax VGA H— Ko7 R
I — FOBEEELHE S BANH Y £3, CPU DS OREIZIAEDHHITIEH Y £ A,
ZI) LERERFRT V=T Y I T A MDD T @FEOT 7Y r—y a3 TfER LanT<
7ZE0,

AR Z B X D EICK L TRFEIE CE EHA, ZTHICERT 2~ —FR— REITEDEROR
BloRt L T irEEEZADRVWL D L LET,

3#  Multiplier Factor:

ZDOT AT MFE, B A2 CPU O EFRLET,

¥  External Clock:

ZDOTAT AE, CPU T Y A RANZAOMEZHELET, B 172 CPU OALEEHIBRIZ
L oT, ZOEHED NSAHREZBZ THRE LIZHE XV R— SR I, BiExshEdEi,

#  Estimated New CUP Clock

ZOHEBAE, RIZVATLERBLIZEEOH LWCPU 7 vy 7 2R LET, 2 OffI,
“Multiplier Factor (3&#) 3 X" “External Clock (JMH7 7> 7)) "OfEIZ L W RESNLET,

#%  PCIE Clock
Z DT A T L% PCI Express O &5 2 # R L £,

Voltage Control:

ZOF T a R TIANNOELEE 22—V —ER LI EEEZU Y B E T, BIEOETERE
DRI CE Dol DV ELS RWHEDRE | ZOREIELT 74V POFFIZLTBNTLEE
W, A7 3 “User Define” (= —H —E) 1L, ROBEEZ FE) TR TEE T,

# CPU Voltage:

ZDOT AT LIE, CPUDa TEELERLET,

# NB 1.8V Voltage:

ZOHEHE, NB 18V EELBIRL ET,

# DDR Voltage:

ZDOT AT L%, DRAM OEEZEIRL E7,

#  HyperTransport Voltage:

ZDOT AT MILDT NAZBJBLEZERLET,

# NB 1.2V Voltage:

ZOHEHAE, NB 12V EEEZBRL ET,

# DDR Reference Voltage:

ZODOTATHIEDDR AEV Y 77 LU ADOEEEZBERL ET,

ATS8
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Power Cycle Statistics:

<Ente>¥—%27 U v/ 35L $ T A==2—ICAVFET,
pGuru Utility V1.00

[OC Guru [ABIT EQ

|[Power Cycle Statistics [ Item Help
PC Up Time 0 Hours

PC Up Time Total 107 Hours

PC Power Cycles 532 Cycles

PC Reset Button Cycles 281 Cycles

AC Power On Total Time 288 Hours

AC Power Cycles 228 Cycles

1 | :Move Enter:Select +/-/PU/PD:Value F8: On The Fly F10:Save ESC:Exit

INSDT AT AL, FEFZONRNT— « A 7 HHEERLET,

ABIT EQ:

<>F—%fioT, OCGuruty b7 v 7+ A=a—M0bH ABITEQ £y N7 v 7« A=a—I(C
VB2 ET,

pGuru Utility V1.00
OC Guru [ABIT EQ
Item Help

ABIT EQ Beep Control Enabled
» Temperature Monitoring Press Enter
» Voltage Monitoring Press Enter
» Fan Speed Monitoring Press Enter
» FanEQ Control Press Enter
1 | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit

ABIT EQ Beep Control:
DT AT LT, ABITEQ EhiFrary br— 2B LI EHIZ L2 LET,

Z—PF—r=2 T
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% Temperature Monitoring:
<Ente>¥—%27 U v/ 35L BT A=a2—ICADFET,

pGuru Utility V1.00
OC Guru [ABIT EQ
|Temperature Monitoring |
Reading Shutdown Shutdown Beep
Enable Temp. Beep Enable Temp.
(*JCPU Temperature 41° C/105° F (*) 85° /185° F *) 75° C/167° F
(*)NB Temperature 48° C/114° F () 65° C/149° F (¥ 55° C/131° F
(*)SYS Temperature 31° C/87° F () 90° C/194° F (%) 88° C/176° F
(*)PWM Temperature 31° C/87° F () 90° C/194° F  (*) 88° C/176° F
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit

CPU Temperature/NB Temperature/SYS Temperature/PWM Temperature:
ZHhBDT AT AT CPU, AT L, EREEOREAZFRLET,

#  Shutdown Enable:

<AN—RA> F—%fio T, VAT A THREZANZLET, CPUNB/SYS/PWM DA
TIREREZEBDE, VAT AIABMICK T LET,

#  Shutdown Temp.:
ZDTAT AL, VAT AORBERE S T2DIZ VAT LA EHEMNICK T T 2IREZRELET,
#  Beep Enable:

<ANN—A> F—Zflio T, BIETHREZ AT Li?‘ AT L)Y CPU/System/PWM DIREE A
L TREREZ B2 L %*ﬁﬂjﬂ‘é b BRERIBY 5,

#  Beep Temp.:
ZOTAT AT, BEREREZERLES,
e ETIREE, BHEIRED RICTRE LR TUIWITERA,

ATS8
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%  Voltage Monitoring:
<Ente>¥—%7 U v/ 95L, W7 A=a—IZADFET,

pGuru Utility Vv1.00
OC Guru [ABIT EQ
Woltage Monitoring [
Reading Shutdown Beep High Low
Enable Enable Limit Limit

(*)CPU Core Voltage 1.32 v (*) (*) 1.6 V 0V

(*)DDR Voltage 2.67V () (*) 3.10 V2.10 V
(*)DDR VTT Voltage 1.32 Vv () (*) 1.55 v1.05V
(*)HyperTransport Voltage 1.20 v () (*) 1.45 v 0.95 Vv
(*)CPU VDDA 2.5V Voltage 2.65 V () (*) 1.80 v1.20 v
(*)NB 1.8V Voltage 1.84 V () (*) 2.15Vv1.45V
(*)NB 1.8V Dual Voltage 1.87 v () (*) 3.00 v2.00V
(*)NB 1.2V Voltage 1.19 Vv (*) (*) 0.00 Vv 0.00 Vv
(*)PCIE 1.2V Voltage 1.20 v (*) (*) 0.00 Vv 0.00 V
(*)ATX +12V (24-Pin Connector) 12.07 V () (*) 14.40V 9.60 V
(*)ATX +12V (4-Pin Connector) 12.13 v () (*) 14.40V 9.60 V
(*)ATX +5V 5.14 VvV () (*) 6.00 V 4.00 V
(*)ATX +3.3V 3.41 v () (*) 3.95 V2.65V
(*)ATX 5VSB 5.14 v () (*) 6.00 V 4.00 V
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit

All Voltages:
INHDOT AT AIEMOBIEER T LET,
#  Shutdown Enable:

KAN—=Z> F—&ffio T, VAT AR THEEZ AT LET, ST 2EREDORNV FSBRE X
D@EMPo T2 VR 72 0 T 25813, VAT MFHIICK T LET,

3#  Beep Enable:

<SAN—R> =l T, BEFHELZANCLET, HETHERORL B RE LY &
STEVEN ST 0 T HEEIE, BEENREY 7,

#  High/Low Limit:
INGDOTAT AT, RNV POLRE FREFZELET,
T BORAOMEIE, EWRADEL Y GRET D2HERH Y £,

Z—PF—r=2 T
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%  Fan Speed Monitoring:
<Ente>¥—%7 U v/ 95L, W7 A=a—IZADFET,

pGuru Utility Vv1.00
OC Guru [ABIT EQ
[Fan Speed Monitoring |
Reading Shutdown Beep Low Limit
Enable Enable

(*)CPU FAN Speed 4800 RPM (*) (*) 300 RPM
( )NB FAN Speed N/A () () 300 RPM
( )SYS FAN Speed N/A () () 300 RPM
( )AUX1 FAN Speed N/A () () 300 RPM
( )AUX2 FAN Speed N/A () () 300 RPM
( )AUX3 FAN Speed N/A () () 300 RPM
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit

CPU/NB/SYS/AUX1/AUX2/AUX3 FAN Speed:

INBHDOT AT A%, CPU, NB, SYS, OTES1, OTES2, AUX FAN ~» ¥ IZHH ST\ 5 7
7 UHMEEFRLET,

¥  Shutdown Enable:

SAN=A> F—FMlioT, VAT ARTHIEZ AN LET, VAT LD, 77 VHER TR
HED BIRNZ L 2T DL, VAT ZAFHBRICK T LET,

s  Beep Enable:

AN—AS o T, BEEMEEREDIC LET. 77 LIS FIMEL 0 IR A,
VS

#% Low Limit:
INoDTAT AL, 77 VEEOTREZRELET,
B 3EUT IR LT 7 DB, WEE=FY IR A At L £ 3,

ATS8
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% FanEQ Control:

pGuru Utility Vv1.00

[oC Guru [ABIT EQ
FanEQ Control
» CPU FanEQ Control Press Enter Item Help
> NB FanEQ Control Press Enter
» SYS FanEQ Control Press Enter
» AUX1 FanEQ Control Press Enter
» AUX2 FanEQ Control Press Enter
» AUX3 FanEQ Control Press Enter

T | :Move Enter:Select +/-/PU/PD:Value

Fl10:Save ESC:Exit

CPU/NB/SYS/OTES1/OTES2/AUX FanEQ Control:
<Enter>¥—%7 U v/ FhHL T A=a—ITADFET,

pGuru Utility V1.00

[0C Guru [ABIT EQ
|cPU FanEQ Control]
CPU FanEQ Control Enabled Item Help
-Reference Temperature CPU Temperature
-Control Temperature High 65° C/149° F
-Control Temperature Low 35° ¢/95° F
-DC Fan Voltage High 12.0 Vv
-DC Fan Voltage Low 6.0 Vv

1T | :Move Enter:Select +/-/PU/PD:Value

Fl10:Save ESC:Exit

(B2 CRESHhTWDHE, BELEEDE/RHIROMEAAEDLEERETH LT
CPU/NB/System/OTES1/OTES2/AUX 7 7 Y EEZFET H LM TEH L 12 7,

#*  Reference Temperature:

INHDT AT AL, CPUNB/SYS/PWM ¥ 2T LDREZF R LET,

s#  Control Temperature High/Low:

7y VEREE Y b a =T D oD D RARRE & s PR &

il

#  DC Fan Voltage High/Low:

77 R O RIEL E kmELEEERELET,

1

XELET,

®

I BVRAOMEL, EVRADEL Y HEBRET 2LERDH Y 7,

Z—P—r== T
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3-2. Standard CMOS Features

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Standard CMOS Features
Date (mm:dd:yy) Mon. Oct. 3 2005 Item Help
Time (hh:mm:ss) 17 : 10 : 27
» IDE Channel 1 Master QUANTUM FIREBALLP AS
» IDE Channel 1 Slave None
» IDE Channel 2 Master None
» IDE Channel 2 Slave ATAPI CD-ROM DRIVE 4
» IDE Channel 3 Master None
» IDE Channel 3 Slave None
» IDE Channel 4 Master None
» IDE Channel 4 Slave None
Drive A 1.44M, 3.5 in.
Floppy 3 Mode Support Disabled
Halt On All, But Keyboard
Base Memory 640K
Extended Memory 1046520K
Total Memory 1047552K
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Date (mm:dd:yy):
ZOTATAE[AL [A] FOEXTHEET S A GEBFE. BEOR) Z&ELET,

Time (hh:mm:ss):
ZOT AT X (] [BIoRXTIRET S A (B, BIEORM) 2T LET,

T#iZ, IDE B LV RAID — Rili 5281} 5, A A 2 HR— KD SATA 237 ZxHIET ¥ v RV
RLET,

IDE &— F RAID £— F
SATA 1 Channel 3 Master SATA 1 Channel 0 Master
SATA 2 Channel 4 Master SATA 2 Channel 1 Master
SATA 3 Channel 3 Slave SATA 3 Channel 2 Master
SATA 4 Channel 4 Slave SATA 4 Channel 3 Master

ATS8
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% IDE Channel 1 Master/Slave, IDE Channel 2 Master/Slave, IDE Channel
3 Master/Slave, IDE Channel 4 Master/Slave:

<Enter>¥—%27 U v/ FhHL T A=a—ICADFET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
IDE Channel 1 Master

IDE HDD Auto-Detection Press Enter Item Help
IDE Channel 1 Master Auto

Access Mode Auto

Capacity 0 MB

Cylinder 0

Head 0

Precomp 0

Landing Zone 0

Sector 0

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

IDE HDD Auto-Detection:

ZDOT AT LTI <Enter> ¥—%#JZLICLS5TIDE RT7ANDRFA—=2EBIBTED X
Il o TWET, T A—Z i LICHBNICERESNET,

IDE Channel 1 Master/Slave, IDE Channel 2 Master/Slave, IDE Channel 3 Master/Slave, IDE
Channel 4 Master/Slave:

[Auto] (HE)) (ZFEET 5 &, BIOS I EOFMED IDE K74 72HHL WA 0E HEIMICTF =
v LET, BOTRIATZEERELEWVEA, 2N & [Manual] (v==7 /L) ([ZHEL, /8T
A =S DOEREFZRZHM L TNDZ LR LTI, ELWREZHB LTI, 73 A
A= — PR A AT ELZ SR L T ZE0,

Access Mode:

ZDT AT MEIBHEND IDE T, AT VB ATHE—RZRIRLET, ZOTATL%2T
74O [Auto] (HEY) REDEFIZLTEL E . HDD OT 7 AE— FZ HEICHRE L E
R

Capacity:

IDTATHMEIT A AT RIATOBBLZOREEFRLET, RIS, VA XEIT 4 A7 F
Ty 7Tl T RNOREIND T A=~y NERT A AT DY A XL DN BENREL 25T
9,

Z—PF—r==2 T
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Cylinder:
IOTAT IV X DA L ET,

Head:
ZDT AT KEFGAIFIAN Y ROEAER L E T,

Precomp:
“ DT AT AL BAI VI HBETHVY VA OEYERLET,

Landing Zone:
DT AT AL, BB /EABNy FRAOToF 47— LTHRESND VY VA DF
FERRLET,

Sector:

ZOTAT AL, bT v IRV Oy ZOREHRLET,
% Standard CMOS Features Setup Menu (2R YD £75 :

Drive A:
ZOTATHIWMO AT 2T7ey = RKIA47 GBE. KIA4T A DOR) OXATEFRELE
ERS

Floppy 3 Mode Support:

IDTATAIEST, BADAL E2a—X VAT LD [3F—RK7uy b — K547 &fHH
L. KZA4T7 A, B, ¥LIFABWAFDORTIA T H2RINT L5 LNTEET, AREEDO T 7 v
E— oA TE2MHALARVEA, 5741 O [Disabled] (EHRFRE) REDEFIZLTL A
YN

Halt On:

ZOTAT A, VAT LAORBPICT T =B SN HGE, VAT AEEIETE0E I 0k
rELET,

[All Errors]: A7 A7 — Fid, BIOS &M TRV T —%KRiNT 2 &P EILLET,
[No Errors]: ¥ A7 A7 — ME, =7 —%Hid 5 LEIELET,

[AllL, But Keyboard]: > AT L7 — hE, ¥—Hh— F= 7 —UHNDOTRTHOTT—|Tx LTI
LET,

[All, But Diskette]: > A7 A7 — hE, T4 A7 v hZ T —LIAOTRTOZ T —|Tx L TEIL
LET,

[All, But Disk/Key|: AT L7 — ki, T4 A7 v hERIEF—FR— =T —DISOF~TD
7= L TEIELET,

Base Memory:
IOTATHE, VAT A VA M=V ENTEAAEY OREFR Lia‘ %A%% U OfE
1% 640K Z 58 L7V AT LA —RMITIE 640K TS, <P —=R— IZ% < DAE

UHPA R VA P—LTHILEHTEET,

Extended Memory:
ZOTATHE, PAT LOREFITKRH SNIILEAE Y ORERRLET,

Total Memory:
ZOTATHE, VAT LATHHTELRAETY ZFRLET,

ATS8
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3-3. Advanced BIOS Features

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Advanced BIOS Features

Quick Power on Self Test Enabled Item Help
» Hard Disk Boot Priority Press Enter

First Boot Device Floppy

Second Boot Device Hard Disk

Third Boot Device IDE CDROM

Boot Other Device Enabled

Boot Up Floppy Seek Disabled

Boot Up NumLock Status On

Security Option Setup

MPS Version Ctrl For OS 1.4

Delay IDE Initial (Secs) 0

Full Screen Logo Show Enabled

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Quick Power On Self Test:

[Enabled] (fEHATHE) IZEXEL TWVWDE, ZOT AT ATV AT AOERE A N LB ERS
VRN TT A MPOST)DHE Z FiF£3, BIOS i3 POST DRIV O DF = v 7 Z4kE L7- Y
Ax v T LET,

Hard Disk Boot Priority:

ZOTAT hiE, N— F?“47\7@7‘~ NMESENERL AR L £ 97, <Enter>F — &4 2 L2k
ST, XDV T A=a—ZAY, ZZTHREENTNA—RT 4 A7 2V AT LEEBIO DD T —
M= U ARICRIRT DR TEET,

ZOTATHIE VRRIRBIRT — b TFARA AT AT ADENPII[NN—RT 4 A7 |DF T =
VIRBDHEEOHRBRELET,

First Boot Device / Second Boot Device / Third Boot Device / Boot Other Device:

[First Boot Device] (5 1 77— k7 /3A R), [Second Boot Device] (5 2 7 — k7 /34 R), [Third Boot
Device](33 7 — F T /A R) TA T ATEALNEREITLHE 1, B2, H3 T4 T7EBRLE
¥, BIOS ITBIR L= RTA T DY~ v Ao TANRL—FT 4 VIV AT LERBILET,
UED32DT AT LUNDT SA A EEE) LI WIGE T, (DT /3 A R % fsh] % [Enabled]
(BEAATRE) ICRRE L T2V,

Boot Up Floppy Seek:

WD 2 DDA 3, Disabled(fifl 3 2)E 721 Enabled(fE i3 2)BRXETE LT, 7 74/
NX Enabled(fE/ L 720 ) TE, 7 7 4V b OFXEIL Enabled. T3, ZOHEHIE, BIOS 23, kit
@ First,Second,Third ® 3 DD 7 — MEZLUNDT NA ANST — M52 LE2RELET, [
B CHELETE, FRTRELE3I SOBBNOLORT— NLET,

Z—PF—r==2 T
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Boot Up NumLock Status:

ZOTATHE, VAT LANEET L & XX —HR— ROT 7 4L bOREEZRE L £,
[On] : ¥ Ed— & LToOHIEx— %y FHGE,
[Off] : RFIF—& L TORMEF—/ 3y NERE,

Security Option:

ZDOTAT A, VAT APNRNRAT = REERTLHEEX - VAT APEREIT L7200, F2iX
BIOS &y N7 v FIZAD EEDHDERELET,

[Setup]: /SAU—REBIOS ty "7 v T 7/ BATHEEOREREINET,
[System]: /XA U — NiZa v Ea—Z RN+ 5-0NNcERESNET,

X2 VT A HEREA NCT 21X, A A A= =2—"TC SetPassword Z IR L FJ, "AT—F
EANTBHEICERSNTHMHAIETIZ, <Enter>F—2H LTS, %2V T4
ERRT D E VAT AN T — L, HHIZBIOS Dy b7 v FA=a—|CHHICT 7 EATE
L9270 FET,

7R — RiEEn RN T EE& W, AT — REZENEEES, 2V Ea—FDr—RAZ5T
T, CMOS DT _XTOFEHRZZ VTICLTNDL Y AT AZEH LT EEY, 2084, LI
WRELET N TOLF T a iV vy hEnE4,

MPS Version Ctrl For OS:

ZOHEBIE, O —R—FMEHTS MPS (HE St v k) A=V a U EIEEL
FT, TOTAT LT, TOT 7NV EOFREDEFIZLTBNTTFEN,

Delay IDE Initial(Secs):

ZDOT AT HIZLY, BIOS [FBIERFM % 5 IEIE T Z LI L » T O F 72Kk IDE 7
NAAZYR—= P TEZENTEET, HERELSTDE, TS RAEZYYL LTIV EMETE B
Wl 24 5 72 OBIERFE AR < 72 0 F97,

Full Screen LOGO Show:

COHBITBWHT LS REEOR TR I L EEE D,

ATS8
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3-4. Advanced Chipset Features

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Advanced Chipset Features

» DRAM Configuration Press Enter Item Help
» LDT & PCI Bus Control Press Enter

NB-SB Port Configuration Enhanced

Dual Slot Detect Mode Auto
X - Dual Slot Configuration Single Slot

- Slave PCIE Link Width None

- Master PCIE Link Width X16

Init Display First PCI Slot

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

% DRAM Configuration:
<Enter>F—% 7V v/ 3hHE, YT A=a—ITAD FT,

Phoenix - Award WorkstationBIOS CMOS Setup Utility
DRAM Configuration

DRAM Timing Selectable Auto Item Help
X - DRAM Clock Auto
X - CAS latency Time Auto
X - Row Cycle Time Auto
X - Row Refresh Cycle Time Auto
X - Min RAS# Active time Auto
X - RAS# to CAS# delay Auto
X - RAS# Precharge Time Auto
X - RAS# to RAS# delay Auto
X - Write Recovery Time Auto
X - Write to Read Delay Auto
X - Read to Write Delay Auto
X - DRAM Command rate Auto
X - Bank Interleaving Enabled
X - Burst Length 4 beats

MTRR mapping mode Continuous

32 bit Dram Memory Hole Auto
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

DRAM Timing Selectable:

ZDT AT MEIDRAM ¥ A I 7 — REFIRL £9,“By SPD” IZ§%E T % & BIOS /X DRAM
EFVa2—/VSPD T —Z EHAWMY . BERICRESNIZEICRELE T, 20747 HIFBEE
D “Auto” FEIZL TBNTLEE,

¥ DRAM Clock:
ZDT AT AE, DRAMEY 2—/LD DRAM 7 12 v 7 3% E LE 9, DRAM £ ¥ =2 — VSR E

Z—PF—r=2 T
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Liczvy 7Y R—FLRNWE, PAT KIRLETR D0, BETE 220 9,

[SPD IZ X ANTHET S & BIOS | DRAM £ 2 —/L 0D SPD 5 — & &5t A AT, B S
TWAEICL > TDRAM 7 12 v 7 Z HEWIIZERE LT,

#  CAS Latency Time:

SDRAM fEERIZHEVY, SDRAM CAS (BT AT RLVAA ha—7) LA T Uy —4 A LEERT
LT ENTEET,

#  Row Cycle Time:

ZOTAT AL RASH 77T 4 TR RASET 77 4 Tl E/ZRA A7 0BEBHY 7Ly
valzfiE LET,

#  Row Refresh Cycle Time:

ZOT7ATHE BB 7Ly aT 7T 4 TR RASHT 7 7 « TR E 721X RASHE B U 7 L
vV a R ERE L ET,

#  Min. RAS# Active Time:

ZOTAT AL, /DO RASHT 77 4 TR ZHRE L £ 9,

# RAS# to CAS# Delay:

ZOT AT AE, R CKRHICT 2 RASHT 7 7 1 7% CAS "Rt/ & IRIERFH 2487 E L £ 77,
#  RAS# Precharge Time:

ZOT AT AT RASHT U Fr — VR A HEE L E T

#* RAS# to RAS# Delay:

ZDTATAE, BRDNCTDORASH T VT 4 T3 RASHY 7 T ¢ 7TIERSR 2 F8E L £,
#*  Write Recovery Time:

ZOTAT AL, RBICEZAALLET — %5 DRAM IC X D ZRIZEE I TH L HIE Iz
MzfEL £,

#  Write to Read Delay:

ZOTAT MIKDFER AT T~ ROSLE ERVICKH L TRBEDOH A7 T —F A hn—7
ke < 2B EAY D 2 HHIE SN 2 E L E T

#  Read to Write Delay:

ZDT AT LFFHPATINHEZIADDBIEERE L ET,

# DRAM Command Rate:

BRAN (V=RAT7V wvP) BDHETDHAEI T FLAZRET L L&, avr FORFLIRELL
HLET,
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#  Bank Interleaving:

SDRAM “E ¥ = —/UHIEIZ L - T, “4 Way” REITRmOMERREZ RIS 5 Z L3 c& 9, Wig
STEREERFRTHE, A B a—F P AT NILELEZFETIITSNESY A, SDRAM £
2 — LDEEFMZ OV TIE, SDRAM E¥ 22— /LD A —H —IZBMEE L7 &0,

#  Burst Length

DDR SDRAM E ¥ o —/UF/N\—A NE— REFRUELET, S—RAFE—REE, 2, 4 £721E8
nly—aryDru T AFREZ READ (FtAiAA) F£7201% WRITE (FEZiAL) N—R MRIC
MTDHBT Y Fr— VA ERLET,

ZHUE, R—=RANEESICHKET DL, TV F ¥ —UTH7DICT RLARZARYA 714D 8
NANMZT 7 EARATHZEHERLET,

MTRR mapping mode

ZOT AT AEIMIRR v B 7 E— REZFEIRL £7, MTRR (Memory-Type and Range
Registers) (37’02t vy FDAEVHEEOT 7 AL Xy v afEhEH#LE4,

32 bit Dram Memory Hole:

ZDTATAEIRNEY FDRAM AF YV R—LE2 V2o 7T AHHEZERLET, 20T AT A
IFEEED “Auto” %EIC L TREBWTLZ &0,

%  Advanced Chipset Features Setup Menu (ZR Y £

% LDT & PCI Bus Control:

<Ente>¥—%27 U v/ 35HL T A=a—ICADFET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
LDT & PCI Bus Control

LDT Configuration Enabled Item Help
Upstream LDT Bus Width 16 bit

Downstream LDT Bus Width 16 bit

LDT Bus Frequency Auto

PCIE Reset Delay Disabled

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

LDT Configuration:
ZOHEA L, LDT REMEE B/ LET,

Z—PF—r==2 T
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Upstream LDT Bus Width:
ZOEAE, Ty T AR —ALDT NAEOMEEHRELET,

Downstream LDT Bus Width:
ZOHEAE, ¥V A MY —ALDT NREDEEAZFRELET,

LDT Bus Frequancy:
M ZODO7 AT AlE, LDT NAEZER L E9,

PCIE Reset Delay:
ZOHEAE, PCIE Yty MNT 1 LA ERBEBR/EDICLET,

% Advanced Chipset Features Setup Menu (2R Y £

NB-SB Port Configuration

ZDOEEBIL, NB-SB FA— h &R ETH72DD0E— RERBIRLET, Z 3R EDE LI
TRXET,

Dual Slot Detect Mode

ZOBEBEE, TaT NI T T 4y I Ay NOT T T 4y 7 E— NRHFEEZRE LET, P
BETIE [Auto (HEY) ] &72> CWEF, [Manual (FEh) | Z2BIRULEZGAE. 797497

REXATBTERTE L L5, 7 a7 /v Ay hgkiEH H (Dual Slot Configuration) 23 %) & 72
iﬁ'o

Dual Slot Configuration

T a7 Ay MEHE— K (Dual Slot Detect Mode) BT [Manual (FH#)) | 28 RT 5 &
CZOWMANRT 774 vV E— RERET DD ﬁEFHTﬁbktwiﬁ“ SUITNTTT 4T H
— F&MH L TWBHHEAIE [Single Slot (> 7 /vAm v k) | %R L, CrossFire £— KT
AT B FETL T DEGEE[Dual Slot (F=7/vAmy h) ] Z8RLET,

Slave PCIE Link Width
ZOHEHIZ, AL—T7 PCIERA#FRLET,

Master PCIE Link Width
ZOHEAE, vAX—PCIEEZF R LET,

Init Display First:

ZDOTAT I, VAT APNEETS L& PCIE £721X PCI A1 v b & £ FHHLT 5 7201058
WLES,

[PCISlot]: AT ABEENTH L&, 9 PClZoHLLET,
[PCIEX]: v AT ANEENT5H & %, £7 PCIE 241t L £,
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3-5. Integrated Peripherals

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Integrated Peripherals

» OnChip IDE Device Press Enter Item Help
» OnChip PCI Device Press Enter
» Onboard PCI Device Press Enter

Onboard FDC Controller Enabled

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

%  OnChip IDE Device

<Enter>F—%7 Vv /95L&, HTA=a—IZAVET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
OnChip IDE Device

OnChip IDE-1 Controller Enabled Item Help
OnChip IDE-2 Controller Enabled
OnChip SATA Controller Enabled
- SATA Mode Selected Emulated PATA Mode
X - SATA RAID ROM Disabled

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

OnChip IDE-1 Controller/ OnChip IDE-2 Controller:

IOTAT ALY, —KBLOZKIDE 2> br—J OFEHAARE/AFREZEIV 2 5 Z &M
TEET, BRDHN—FRFIA7ar bu—7 %8BT 51203, [Disabled] (ff IR 7T6E) % 24N
LTL7EEN,

OnChip SATA Controller:
IDTAT L, FrF v T SATA =2 ba—F OFR/ED 280 2 9,

Z—PF—r=2 T
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SATA Mode Selected:

ZOHEBX, SATA OEF— FZ®RINL EJ, Microsoft ftD 64 £ b A XL —F 4 VTV AT A
ZEALTWA5A1X [AHCI] £— FEZRIRLET, ZhUS0%5A L [Emulated PATA] E—
FZBRLET,

SATA RAID ROM:

ZDIHEH L. SATA RAID ROM % AN/ AN E L ET,

%  OnChip PCI Device:

<Ente>¥—%27 U v/ 35HL T A=a—ICADFET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
OnChip PCI Device

OnChip Audio Controller Enabled Item Help
OnChip USB Controller Enabled

- USB 2.0 Controller Enabled

- USB Keyboard Support via 0os

- USB Mouse Support via os

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

% Integrated Peripherals Setup Menu (ZRE D £3:

OnChip Audio Controller:
IDTATLEZA—T 4 Farbe—J%FHTELLIICLET,

OnChip USB Controller:

ZDTATAEAYR—RNUSB 2 b —J5FHATELLOCLET, 2OT7AT 2%
Disable (il L7Z2\Y) IZE%ET H L. “USB 2.0 Controller” . “USB Keyboard Support via”
LU “USB Mouse Support via” 7 A 7 LX Integrated Peripherals (% 4 /8 704) A ==2—7T
BIRTEEHA,

#  USB 2.0 Controller:

ZDOTATAEIAR—FUSB20 a2y be—J %A TE5 L5 LET,
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#  USB Keyboard Support via:

ZOT AT AL, DOS E8H T USB ¥—AR— Fafi {7 572®IZ[BIOS]% . OS &5 T[OS] %%
WLET,

#  USB Mouse Support via:

ZDOTATAHIZEY, DOS BEE T USB vV AZEHT 5720 D[BIOS] %, Fizid, F721% 0OS
BREECIX[OS]|ZRIRT A LN TEET,

%  Onboard PCI Device:
Phoenix - Award WorkstationBIOS CMOS Setup Utility
Onboard PCI Device

Onboard LAN Controller Enabled Item Help
- LAN Boot ROM Disabled
Onboard 1394 Controller Enabled

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Onboard LAN Controller:
IDTATAIAVAR—RLAN v br—J2FHTE DL oICLET,
¥  Onboard LAN Boot ROM:

ZDT AT LI A R — K LANBoot ROM # il C&x 5 koI LET,

Onboard IEEE1394 Controller:
ZOFA Ty aiE, IEEE 1394 22 hu—T OF R/ Y0 R ET,

% Integrated Peripherals Setup Menu (ZR YD £3:

Onboard FDC Controller:

ZDOTATAFIAVYAR—FRFDC a2 ba—J%HTEX5L 51 LET, Enabled (EHT %)
F 7213 Disabled (fEfH L72\Y) IZERETE £, T 7 4/ b Enabled T,

Z—PF—r==2 T
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3-6. Power Management Setup

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Power Management Setup

ACPI Suspend Type S3 (Suspend-to-RAM) Item Help
- Resume by USB from S3 Disabled
Power Button Function Instant-Off
Wake Up by PME# of PCIE Disabled
Wake Up by PME# of PCI Disabled
Wake Up by Onboard LAN Disabled
Wake Up by Onboard 1394 Disabled
Wake Up by Alarm Disabled

X - Date(of Month) Alarm 0

X - Time (hh:mm:ss) Alarm 0:0:0
POWER ON Function BUTTON ONLY

X - KB Power ON Password Enter

X - Hot Key Power ON Ctrl-F1
Restore on AC Power Loss Power Off
AMD K8 Cool’n’Quiet Control AUTO

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

ACPI Suspend Type:

ZOTAT AL, YA RE—ROZ A THEBEIRLET,
[S1(PowerOn-Suspend)] : EJFA A RE§pE# A ATREIC L 97,
[S3(Suspend-To-RAM)] : ¥ A~ Kkt RAM #EREZ A AIREIC L £,

# Resume by USB from S3:

WD 2ODF T a o NIEETE £ Disabled (1 L72VY)  F721% Enabled (fH45) .
57 4 /v N Disabled (/5 L720>) T3, Enabled (f&/H75) \ZRETH &, A F v 7 USB
WCHBE G2 5T XTOAXRY MIBERT T LV AT AR LET, ZiE,
“ACPI AR RDF AT 23 [SHSTRNIHRE SN TN D L EILOHFETEET,

Power Button Function:

Z DT AT Ald Delay 4 Sec 7> Instant-Off ICHFETE LT, 7 7 A/ M Instant-Off TH, A
TAMEBHFICERR S H 4B LSS5 L VAT LIV 7 M AT (YT h U =TI
K2R T—F7) F—RZEDLYVET, ThEBRAY VA —N"—F 1 FEILOET,

Wake Up by PME# of PCIE:

[Enabled] (£ JH FIBE) IZRRE L TV A L &, EFT AR LAN I — K72 E DA R — K LAN X° PCIE
H—RIZT 7 BATDHE, VAT LEMNOERITHRE 720 £9°, PCIE 71— RIFFFONE Z L
REVAR— N TH2RERHY ET,

WakeUp by PME# of PCI:

[Enabled] (fEAFIHE) IR ELTWVWDH L X, FFT AL LAN 1— K72 X DA R — K LAN < PCI
N—=RIZT 7 8RATHE, VAT LEMWEZTHRREE 22D £7, PCL 7 — NI Z Lk
Y R— T 206ENHY ET,
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Wake Up by Onboard LAN:
[Enabled] IZFXESINTWNDE, TxA T T v THREIZKIS L7 LAN 71— RZBL T, Y7 b-
F7REDOPC %V E— I LEBSEDLZ ENTEET,

Wake Up by Onboard 1394:
[Enabled] ICEXESN TS E, VoA 7T v 7RIS L7- IEEE1394 23 L C, Y7 A
TIRREDOPCZ Y E— "D OEBSEDLZ N TEET,

Wake Up by Alarm:

WD 2ODAT v 3 VINEE TX £ Disabled (fEH L7e\Y)  F721% Enabled (fEHT %) .
57 4V MX Disabled (f£/7 L 7)) ¥, Enabled ($8/H75) \Zi%ET D&, RTC (Y T4
ALy YT T—LRY AN RE—RNL VAT AEZNFOEZ T A ERFEERETCEET,
%  Date (of Month) Alarm/ Time (hh:mm:ss) Alarm:

Aff (H) 77—ALEHT 7 —24 (hhommiss) 2R ETHZ ENTEET, BETHA U b
IETR_RT, NU—F T LIV AT AEROELET,

Power On Function:

ZOTAT AL, VAT LOEREANTT HHEERRL ET,

[Password]: /SATU— REMHEA L CUATLOEBREANILET, ZOFT v a U ZRILT

NH, <Enter>Z LTS, NAT—=REANLTLZEN, KRS LFETANTEE

T, EMEIZFR U RRAT— K2 AN L THEER LD, <Enter>%# L E9,

[Hot KEY]: <F1> 7°6 <FI12>FE TO ENDDOMREEZHEH LT, VAT LADOEREA T LET,

[Mouse Left]: ~UV ADLERZ X T NI ) v 7 LT, VAT LAOBREZAIZLET,

[Mouse Right]: ~ TV ADERZ L XTI Y v 7 LT, VAT AOER AT LET,

[Any KEY]: ¥—A— ROEEOF—%2 AL T, VAT L2OEREA I LET,

[BUTTON ONLY]: BFRA X > OHREZFER LT, Y AT LAOEREA AT LET,

[Keyboard 98]: “Keyboard 98" A4 —R— ROEWRA L RY &2 FEHA LT, VAT LOEHE A
L ET,

# KB Power On Password:

<Enter>% — %3 L AT HRNAT—REANTLZENTEET, ARETTDHE, 8

ExRIFLTBIOS REA =2 —%&T L, AV Ea— XU AT LEHERTLILERHY 7,

WIZavEa—F%2vyy MUV LTcLE BRAZ VEEHLCara—2OERY A

T2 LETEERA, AV Ea—XOEREA T HITE, NAT— RE AT D 0N

HYET,

# Hot Key Power On:

WD 15 DAT L 3 U MHEETE £9: Ctrl+F1 ~ Ctrl+F12, Power (EJR) . Wake (FFONEEZ L) |

AnyKey (FEEDX—) . T74NMECori+FI TT, mHETHHy bF—ZBRL T, v

DERZEF AT DHIENRTEET,

Z—PF—r=2 T
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Restore on AC Power Loss:

ZDTAT L, ACEBRICEENEAELTZHKO VAT AEMEEZ IR L £,

[Power Off]: AC E i DFEEH i:?&/}ﬁﬁ)lﬁuﬁbfﬁ VAT LAOBIITA TR L TT,

VAT LDOEREAS T D é: BIRARZ 2T HERDY 77,

[Power On]: AC B D P «m@@faa VAT AOBFRITHBNCA T ET,

[Last State]: AC EJHD “*?& _@(Jﬁbxﬁl@?ét AT KT Aﬁ“iﬁ)%ifﬂ“éﬁmﬁt%&:

EOE9, ACERDOBENIA L L XV AT AOBRENRA 7108 o T =5, EBESEIE

Lot EZH VAT AOBERITIA 727 o2 FTT, ACEFRDOEENEE LI XV AT
DEFENA N2> TN b, BIRNBEE L & &IV AT LAOEFRITA R $9,

AMD K8 Cool ’n’ Quiet Control:
ZOFA T 3 1%k, AMD K8 cool and quiet BEREAZ AN L7 D HEDIZ L2 D LET,

ATS8
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3-7. PnP/PCI Configurations

Phoenix - Award WorkstationBIOS CMOS Setup Utility
PnP/PCI Configurations

PCI/VGA Palette Snoop Disabled Item Help
PCI Latency Timer (CLK) 32

PIRQ 0 Use IRQ No. Auto

PIRQ_1 Use IRQ No. Auto

PIRQ_2 Use IRQ No. Auto

PIRQ 3 Use IRQ No. Auto

PIRQ 4 Use IRQ No. Auto

PIRQ 5 Use IRQ No. Auto

PIRQ 6 Use IRQ No. Auto

PIRQ 7 Use IRQ No. Auto

** PCI Express relative items **
Maximum Payload Size 4096

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

PCI/VGA Palette Snoop:

Z DT AT LIZ.,MPEG ISA/VESA VGA /7 — K23 PCI/VGA TIEEI CX 2 E 0 aRELET,
[Enabled]: MPEG ISA/VESA VGA 7 — Fi&, PCI/VGA TE#IT& £,

[Disabled]: MPEG ISA/VESA VGA % — KX PCI/VGA TEEH L £ A,

PCI Latency Timer(CLK):

073\b255i’C®DEC(10L/£)§7?75) RETEXET, 77NV MOREIL32TT, ZOTAT
LV PCl VAT vi—ray 7 BIEREZRETHI ENTEET, 2V, BIEIE
u\7m VI BEBRETE LI LRV ET,

PIRQ 0 Use IRQ No. ~PIRQ 7 Use IRQ No.:

ZDOTAT AF, PCl 2Aay MRV AIFTZT A A0 IRQ HE2HEEIXTEHTRHREL
s

Maximum Payload Size:

ZDT AT AlE, PCIExpress 7 /5 ADHE R TLP <A 0 — P A ZZRELET,

Z—PF—r=2 T
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3-8. Load Fail-Safe Defaults

ZIOFFaiITF 74 PO BIOSEZr— LT, RbBEE LT, REDY AT Lh3T 5 —
v AERBLET,

3-9. Load Optimized Defaults

ZDF T a it HEREOFT 7 3L PO BIOS #FEEZ T — R LT, KDY AT LNT —~
VAEFERBLLET,

3-10. Set Password

ZDOAT v a X BIOS HEREMRE LD, av Ba—F~OT 7 A%EHIRLET,

3-11. Save & Exit Setup

TOF T a ABEREZEFELTBIOS By T v F A= —52 KT LET,

3-12. Exit Without Saving

ZOF TV ald, BEEARGFETICBIOS Yy F T vy F A= a2 —E2 KT LET,
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F—F 4 FFANDAL R P—Ib

kA =T 4 F RFTANRNDA R F—)v

AEDA v A M= FIELBE Y 2 v M,
Windows XP AR L —F ¢ J L AT MK
DNVTWET, ZOfd 0S DA A h—)b
FIEEHEHERS 3 v MTOWTiE, FD 0S D
FU AT = ORI T IEE N,

KA NEa2—7 ¢ U7+ CD % CD-ROM
KIALTIHATDE, A1 VA —VT 1
77 APEHEICIITLET, BEICE
ITLRWEA. ZOCDDAL—FF 4 L7 b
VCETT 7 ANEELTNLI ) v T L, A
VA R—=L A= 2= A5 TLEE Y,

AVARN=NAZa—ZAsTcb, I—Y
JV % [Drivers] # 7 (2% 8 L £ 9, [Realtek
Audio Driver]Z 7 V v 7 LT 2 & W, RD
W NRRSNET,

Realtek High Definition Audio Driver Setup (1.96)

1. [Next] 22V v s LET,

Realtek High Definition Audio Driver Setup (1.96)

install [ <ok [ Fien . cancel,_

2. [Yes, I want to restart my computer now.
] BRSNS L5 BEID LE T, [Finish]
7V LTA VA M—LEKRTLET,

v You must restart your computer befare the new settings wil kake effect.
. Do you want ko restark your computer now 7

3. HE#®, A—T 44 KT A4 D EHEW
ey vy FENET, By T v IR
SETT5EEXKOL S RMmAERIINE
T, [Yes (1Fv) 1 227V 2 L, b5 —FE
aUEa—FEHEBHIE TN,

Z—PF—r=2 T
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LAN FZA RS04 X p—rb

B-1

8% B. LAN RZA DA A h—)L

AEDA A M—/VFIREEHE Y 2 v M,

Windows XP A XL —F 4 L J 3 AT MK
SNTWET, ZOfd 0S DA A h—)b
FIEE M =2 v MO T, 2D 0S D
AU AT Y= DRIRICHE > TS0,

KA NEa2—7F 4 VUF 1+ CD % CD-ROM
KA TIHHFATDHE, f VA =T 1
77 AN AENICETLET, BEIICE
ITLRVWEA. ZOCDDL—FF 4 L7 k
VCEITZT 7 ANEL TN Y 7 L, A
VAR A= 2= A5 TLEE,

A UVA RN A=Za—IZA2T2b, h—Y
)V % [Drivers] # 7 \Z %8 L £ 9, [Realtek
LAN Driver]Z 7 UV v 7 LTLZ&EW, kO
EHAERINET,

REALTEK Gigabit and Fast Ethernet NIC Driver Setup -- LanSetup 3

‘Welcome to the InstallShield Wizard for
REALTEK Gigabit and Fast Ethemet NIC Driver

The InstallS hield® Wizard will install REALTEK Gigabit and
Fast Ethemet NIC Driver on your computer. To continue.
dlick Nert

Cancsl
1. [Next] #27 VU v7 L%,

REALTEK Gigabit and Fast Ethernet NIC Driver Setup - LanSetup
InstallShield Wizard Complete

Setup has finished instaling AEALTEK Gigabit and Fast
Ethemet NIC Diiver on your compute.

2. [Finish|%7 Vv 27 LTA A h—)V%
MTLET,

Z—PF—r=2 T
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ULil1575 SATA RAID FZA73DA > X p—/b

C-1

f148% C. ULi1575 SATA RAID K5 A XD

A AN—)L

KREOA A=A FIEE WS 5 v b,
Windows XP AR L —F ¢ J T AT MK
SNTWET, TOfd 0S DA A h—)b
FIEE MY 2 v M2 T, £D 0S D
FU AT Y= DRI TN,

KA NELa2—7F 1+ UT 1+ CD % CD-ROM
KA TIHHFATDHE, A VA =171
77 ANEBMICETLET, BEIICE
FLARVEAS. ZOCDDAL— 7 4 L7 b
VCEIT T 7 ANEE TN w7 L, A
VAR= A= 2—T Ao TLIEE N,

A UA NNV A =2 —Z AT, I—
JV % [Drivers] # 7 \ZB 8 L £ 9, [ULi1575
SATA RAID Driver]z 27 U v 7 LTL 2 &
WV, ROBHENRRSINET,

ULi Chipset Driver 3

e—
i - Welcome to the InstallShield Wizard for ULi
Chipset Driver

The InstalShield® Vizard wil install UL Chipset Driver an
your camputer, To continue, elick Next

Cancsl
1. [Next] #27 Uy 7 LE7,

Hardware Update Wizard

This wizard helps you finish instaling software for.

@ ULi SATA/RAID Contraller (M1575)

Click Mext ta continue.

2. [Next] 27V v 27 L%E9,

Hardware Update Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for

@ ULi SATA/RAID Controller (M1575)

The hardware yau installed wil nat work unil you restart
your computer.

Click Firizh to close the wizard.

3. [Finish] #27 V> 27 LE7,

Z—PF—r=2 T
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Setup has finished copying files to vour computer. Before you can
uze the program, pou must restark pour computer.

Choose one of the following options and click DK to finizh setup,

¢ i¥es, | want to restart my computer now.

" Mo, | will restart my computer later.

4.  [Yes, I want to restart my computer now. ]
ERHRE NS Lo BEIO LET, [Ok]Z7 Y
I LTA VA M= LEKTLET,

ATS8



Cool 'n' Quiet FZANDA 2R p—rb

D-1

f+8% D. Cool 'n' Quiet K7 A XD A X h—/L

KRIEDA VA M= ATFIELEEHS =2 v i,
Windows XP A XL —F 4 L J 3 AT MK
SNTWET, ZOfd 0S DA A h—)b
FIEE M =2 v MZOW T, £D 0S D
FU ATV = OFRIZHES T IEE W,

KA Nba—7 U7 4 CD % CD-ROM
KA TIHHFATDHE, f A —1T1
77 AN AENICETLET, BEIICE
ITLRWEA. ZDOCD DL—FTF 4 L7 b
VCETT 7 ANELTNI ) v T L, A
VA R=L A= 2—C A>T IEE N,

AVARN= NV A=Za—llAoTch, I—Y
)V % [Drivers] % 7B 8 L £ 9, [Cool '
Quiet Driver]Z 27 V v 7 LT I2E W, RD
BEEARRINET,

w Welcome to the InstaliShield Wizard for Athlon 64 Processor Diiver

<pack || {Hen:

1. [Next] #7VUv7 LET,

et
rioad fomthis serveror CD-ROM ['Sofwae’], Lcersee.
s oftis Agreement.

AMD granis L

2. [Yes] #7YV v 7 LET,

iver - InstallShield Wizard

[README.TXT e for AMD Atronfm) 64 Processar Diiver

fnstal [ oo || (e |

3. [Next] 27Uy 27 L%,

Athlon 64 Processor Driver - InstallShield Wizard

Install5 & il Cancel

4. [Next] 27V v 7 L%ET,

Z—PF—r=2 T
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1/8% D

Athlon 64 Processor Driver - InstallShield Wizard

InstallShield Wizard Complete

InstallS cpack || Finsh cencel |

5. [Yes, I want to restart my computer now.

] ZBIREND X5 BEID LET, [Finish]

7V I LTA VA M= LERTLET,

Power Options Properties

Power Schemes | Advanced | Hibemate | UPS |

this computer. Note that changing the settings below will modify

o ﬁ Select the power scheme with the most appropriate settings for
the selected scheme.

Power schemes

Home/Office Desk A

Home/Dffice Desk
Portable/Laptop
Presentation

uir off maritor TBfer i v

Tum off hard disks: ‘ Newer ~ ‘

Swstem standby ‘Nsver v‘

Apply

6. VAT AFHEEE 3> ba— LR
S [EIHA 7> 3 >] (Power Options) %
ER L. [B/NOBFREH] (Minimal Power
Management) D BB E % #R L T Cool
n’ Quiet ZAZNC L TLEE NN,

¥ : X E:Windows 2000 £ 7213 ME ¥ X T A
IZ DUV Tld. Windows 2000 33 & OF ME FHD
Cool *n> QuietY 7 b7 = 71 > A k=)
SN TWBEE. ADM Cool *n’ Quiet £ 7 7
[FBIRA 7> 3 > (Power Options) D RIS
RENET, TITlE. Cool ‘n’ Quiet 2H
ST B-»ic [HEE— K] (Automatic
Mode)lCiRET AMENH D £9,

ATS8



USB2.0 FZANDAL 2R p—2b E-1

fték E. USB2.0 RTANRXDA VA ~—)L

¥E : Windows XP & 7213 Windows 2000 {235} % USB 2.0 KT A DA A h—/LiX, v~( 7=
V7 MMEDOT =T A S HIEHTD Service Pack & ZFIH L L X1,

Z—PF—r=2 T
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ABIT uGuru 2 —7 o J 7 o4 DA X p—/b

F-1

1% F. ABIT pGuru =—7 4 U7 4 DA A h—)L

RIEDOA A NM—)LFIEEHEE Y 2 v ME,
Windows XP A XL —F 4 L J 3 AT MK
SNTWET, ZOfd 0S DA A h—)b
FIEE M =2 v MZOW T, £D 0S D
F AT Y= DRRRICHES T IZE N,

KA NEa2—7F 4 VUF 1+ CD % CD-ROM
KA TIHHFATDHE, f VA =171
77 AN AENICETLET, BEIICE
ITLRVWEA. ZOCDDOL—FF 4 L7k
VCEIT T 7 ANEFT TN Uy L, A
VAR A= 2= A5 TLEE,

A UVA RN A=Za—IZA2T2b, h—Y
Jv % [ABIT Utility] # 7iCBEh L £,
[ABIT pGuru]# 7 U » 7 LTL £ &0, (RO
EHAERINET,

InstallShield Wizard E

Welcome to the InstallShield Wizard for ABIT
uGuru ¥3.0.1.5

The InstallS hield® Wizard will install ABIT uGuru ¥3.01.5
o your computer. To continue. click et

Cancsl
1. [Next] #27 VU v7 L%,

InstallShield Wizard

Choose Destination Location
Select folder where Setup wil install fles.
Setup wil install ABIT UG V3.0.1.5 in the following folder

Tainstall to this folder, click Next. To install to 2 different folder, ciick Browse and select
another folder,

Destination Folder

C:\Program Files\ABIT Browse...

¢Back e ‘

2. [Next] 27U v 27 LET,

InstaliShield Wizard

Reboor

The InstaltShield Wizard has successhull installed ABIT uGuru
V3015, Before you can use the program, you must restart
your computer.

& §zs, T want o resiart my compuler now}
€ Mo, | will restart my computer later.

FRieboat

Firish |

3. [Yes, I want to restart my computer now.
] #Rans X5 88O LET, [Finish]
BV LTA A=V ERTLET,

Z—PF—r=2 T



18 F

ATS8



POST =2— F/E#H G-1

£14% G. POST =2— FiEZH

AWARD POST 21— RiEE:

POST -
(16 #EHE) e b
CF CMOS R/W #EEED T A
F v 7y NOFROYL
co - KU RAM #9275,
L2 Xy v arNCT S (Y NTEF)
NR—=Y I DF Ty NVIRE BT O T T A,
AE Y ORI
Cl1 -DRAM O 4 X fEfH, ECC O H @i,
L2 F vy aOHERM (V7o NTUF) .
C3 JEA#E & 3u7- BIOS = — K% DRAM IZHETE,
s Fv 7Yy b7 v &Za—) LT, BIOS % E000 5 X1 FO00 &+ K7 RAM
Izar—,
01 T N1 A 1000:0 [ZALE S AU TV 5 Xgroup = — R & JRERE,
03 W13 Superio_Early Init 2 A v,
05 1. i % V89, ‘
2.CMOS D=7 —7F v 7 &iHE,
s 1.8042 4 ¥ 7 = — A& %,
2. 8042 H O & & ML,
1. Winbond 977 2 U — X ® Super /O F v 71Tk L TRk e —HR— K= b

08 —Z %7 A b,

2. ¥ —AR— A BT =—AEH/IT 5,

1.PSR VU AA VBT = —ABEYTE (FTFay) ,

2R —=FBLOAS U H T 2—RARAT v T D®KIZ DFH—FR— R~ AHKR—

0A FOBBIRI (57 a0
3. Winbond 977 ~ U — X ® Super /O F > FIZk L THEF—A— K& Vv I,

OE FOOOhEZ Av hix RUETANLT, N0 RW RIGETH D070 0%
RAE, TFANBERKLED, AV—INRE—TFE2RLET S,

10 77y vaOffEE BEMR LT, M7 Ty a RIW 22— K% F000 N
T A A AEIRICE— R L7225, ESCD BLUDMI 2% 7HR—h,
T —F 71 OTNTY XLEMHEH LT CMOS [EEENOA 7 7 2 — A%k

12 &, Flo, VITNEA LD 0y 7 BRIREEZREL T, KICA——F A K
T,

14 Fo Ty NOTF TN MEEF T2y NN ST A, Fy T2y bO
77 /)b MiliE OEM %2 X Y MODBINable,

16 Early_Init Onboard_Generator 23 E# SN TWAHEOPMA R —Krm v s

Pxxl—4#, POST26 b <L &,

Z—PF—r==2 T



G-2 1187 G
18 772 K, SMI OFffJE (Cyrix 7213 Intel) 35 LN CPU L~L (586 & 721 686)
& te CPU MFROMH,
PIAEI D AZR Y MR, BFICHRES N TWRWEE, 37XTO /W EY iAA
1B I% SPURIOUS_INT_HDLR & S/W %]V iAZ 7> & SPURIOUS soft HDLR (2% 64U
EX
1D W) EARLY PM_INIT A A v .
1F F—R—R{¥lza—F (/= T v 7DFT7y b7 H—20) ,
21 HPM O (/=T o2 DT Ty v THr—24) ,
1.RTCEDOZY4MEEF = v 7 il : 5Ah OfEI% RTC 7y DB MR/l & 720 £
7
2 2. CMOS #%7E% BIOS A ¥ v 7 iZr— K, CMOS F = v 7 AR KM L7I=54 .
ZORDOVIZT 740 MEZERA L TLIZE N,
” PCI & PnP %4 234 BIOS U Y — R % #&fii, ESCD 2 A %) Tdh i, ESCD
DUH T —IEREZEICAN T LI,
7 — U —PCI #I1#1k:
’5 -PCI N RAFEHS ZFIZE,
AFV&IO VY —AZE D YT
-F %72 VGA device & VGA BIOS ZIR%& L, 1% C000:0 IZ ANVET,
1. Early_Init Onboard_Generator 734> 7R — K7 1 v 7 ¥ =3 L—Z YL & E
HINTWRWEAR, ThEhorsay 7 ) Y —R 8T 5bE&, PClI&
26 DIMM A =& v MIZEIZD 7,
2. Init > AR — K PWM
3. Init 4> R — K H/W &= Z 3L E
27 INT 09 /N> 7 7 Z HIHHE,
1. 0-640K AE U 7 KL &% LT CPU &S MTRR (P6 & PI) & 7' 12 7' T A,
2. Pentium 7 7 A CPU IZ%} LT APIC % ¥k,
29 3.CMOS &y N7 v FICL o T =V —F vy heTarIh, fl:
—RIDE 2> br—3,
4. CPU # % JIE,
2B v 4 BIOS %OV L
L2234 bEE7 x> b EAE (7 a )
2D 2. Award % A b/, CPU OFfi¥H, CPUME, Z/LVEna I2ED, A A7 Y
— VT 4 AT VAITERE TR,
3 Early_Reset KB NI/ > TW DA, ¥—A— K& V&> b, fil: Winbond
977 > U — X Super /O &~ 7, POST 63 & ZHE 7280,
35 DMA F % XL 0% T A b,
37 DMA % X/ 1 %27 A I,
39 DMA X—J LU AX%T A B,
3C 8254 T A b,
3E F ¥ RV IR LT 859 ENN AR~ AT By NaT A b,
40 T RV 2IZKE LT 8259 BV IAHR~SY AT By NET A B,
43 8259 H¥REZ T A b,
47 EISA 21> b ZFH#i1k,

ATS8



POST =2 — FiES# G-3

L& 64K R—Y DREDI T NI — RETAMTLHZEICLoTHEIAEY %
49 FH5
2. AMD K5 CPU IZ%f L CEZXIALEI VY CTETa T L,
1.M1 CPU ® MTRR %711 7' A,
2.P6 7 TAIZRI LT L2 ¥ v v ooz L, #72% v v o 2 R/ i
4E RO CPU R T /T A
3.P6 7 T A® CPU IZ%f LT APIC ZHIHL,
4. MP 7T v b7 4 —A LT, & CPUIKDOF ¥ v ¥ = AIREARFFAA —F L2
W, ¥ v o ARERHIPH A XV /N S e s R,
50 USB % #)#{k,
52 TRTCOAEYET AN (TRTOIRINIZAEVEZ00IZTIT)
53 HW ¥y R/ TRAT—=RE 7 YT (T a )
55 FatyPolEERr SRy IOS Ty b T r—h)
PnP & 3% 3R,
57 W13 ISA PnP % )1k,
-CSN %4~ T ISA PnP & |2E| 0 24T,
59 fEA STz Trend 7 4 VAP IE 22— R &2 W)L,
sB (A7 a HRE
FDD 75 AWDFLASH.EXE # AJJ 95720 D A v —V %2 FR (A7 a V),
D 1. Init. Onboard_Super 10 % #JH#i{t.
2. Init Onbaord AUDIO % #Jii{t
. Setup = —7 4 U7 4 DATIBATRE;DFE VW, 2D POST A7 — %5 CMOS Ok
v T v T a—F 4 VT 4 & AT D FE TIEATIRAEE,
63 Early Reset KB NEFHR SN TWRNGE, F—FR— K& Uty b,
65 PS/2 = 7 R &1L,
67 BgBE 1 — L ¢ INT 15h ax=E820h (T%f LT A€ U %A XDIEH % Yl
69 LXyvyiartdilt b,
6B Setup B L O HEMERBENICFLIR SNFHEBICE-CF v Ty NLURA X &
Tay g A,
1. VY =A% 9T ISA PnP #2504 T,
6D 2. Setup NOXIIET 2 HH B“AUTOIZRRE STV D4, A— K Lo COM
A— MR — h&EIY YT,
oF 1. 7uyv—ar hue—7zg#1,
2.400— Ry =7 TC7uy b —llETL7 s — L Kby b T v 7,
75 3 _Co IDE ¥#& (HDD, LS120, ZIP, CDROM 72 &) ZMHL, £ A b—
b
(7" a HHE)
76 AWDFLASH.EXE % A JJ:
-AWDFLASH 37 8 v E'— R T A ZIZA 20> 254,
SALTHR2 8 L TV A A
77 U TIVR— b ENXT LLR— b R,
7A avatyhERELL A M=,
7C Init HDD # & iA 7774

Z—PF—r=2 T
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AWE L IR R— FEINTWVWDEHAE, TF A ME— NI &z,
F T —BRETIEA, T —E2HE L AN EFE,
ST T —NEAELZZWEA. FRIEFI =B EIN TV AT,
*EPA 73RS v A X EhTzndx= T VT,
ESPOST.ASM D R & — k
1.7y 7y NEREEY v 7 23—,
82 2.EPAu:“4:;oT1ﬁﬁﬁénTb\ TXARNT x> MNEEIE (E@E e T
LIRS R—=1) |
3. AT — RBRRESNTNDEH, SAT— RO AN ZRD D,
83 AB DT XTOT —HF % CMOS ([ZIRF LIET
84 ISA PnP 7' — k35 2 W)L,
85 1. USB HcA&#31L
2. B Z T ¥ A NE— RIZU Y EZ
87 NET PC: SYSID ##1& D #EEE
89 1. IRQ % PCI 7 /34 RIZHI Y KT
2. AFVDO LM TACPIEER Y T v,
SB 1. T_XTCTOISA 7 X 7% ROM %O L
2. 9T ® PCIROM % MO L(VGA % FR<)
sD I.CMOS v FT7 v W~ TRY T 4 F = v 7 OIS0 0 Bz
2. APM #1#i1k
SF IRQ ® J A X% {2
93 Trend ¥ « /L ABSIE 22— RIZ% L C HDD 7' — k& 7 Z{FEHRDFi A H,
LL2FXy v =a2H%
2. BHEIHE A T /T A
3. @l E e ST A
04 4. F v 7y b OEKIIEIL,
5. EIEAE B OO B AL
6. Wiffi & 7 4 AT LA OEHREHEE
7.K6 EXALEI VY TET BT T A
8.P6 7 7 ADEXIALLGRET T T A
95 Update & —74R— K LED & typematic rate (5 —@D 74— h U &'— F#HE)
1. MP £ & 1§48,
2. ESCD % #A#4E L 58T,
9 3.CMOS > F = U —% 20h £721% 19h ITFEE,
4. CMOS Hff] % DOS DX A ~F v 7iZr— K,
5. MSIRQ D% FE 8 E 3 & WG4,
FF A% 7 — H(INT 19h),
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POST =2 — FiES# G-5

AC2005 POST =— RE# :

POST
(16 #EE) " H
BEA L~V R
8.1. EBIEA > —r v 2D
8.2. ATX EIEE DA
8.3. ATX FEJEEE OWERE T
8.4. DDR FEJE DT T
8.5. CPU = — FEBJEICH LTPWM Aty h T v 7
8.6. CPU =2— REEIZK LTPWM 27— K
8.7. CPUT—EEET = v
8.8. CPU = 7 BIEDHEFE T
8.9. s ey 72 xL—41C
8.A. )—=AT7) oPF v Ty VEEOHET
8.B. AGP EEOHEfFTE T
8.C. 3VDUAL LD HEfF5E T
8.D. VDDA 2.5V FEBJEDOHE(FE T
8.D. GMCHVTT &+ O Efi7E T
8.E. CPU 7 7 VHEDT = v 7

8.F. FTACOEREERE T &7 Y — b
uGuru FIH1 7 BB X & 5ET

9:0. AWARD BIOS ##E) Y = 7 &K
BRA7—HF VA
9.1. BIEA 7 v —hr v 2 & Bk
9.2. TXTOBEPOT P — MEIL
9.3. FBIFEA L OT Y — 7L
9.4. LDT NAERB T — MEIE
9.5. CPU a2 7 BJEICKT 5 PWM O 7 H— MMk
9.6. CPU 2 7 EBJEDT P — MEIE
9.7. CPU a7EIEDF = v 7
9.8. ATX EREEDO T Y — MEIL
9.9, BIRA T —lr o ABET
£ DA
F.0. RKEE> b
F.1. V7bhu=TUEky bk
F.2. BIRA S —Hr  ADEA LT T
F.3. BIRA T =l ADHEA DT

EE: /N AL, AC2005POST 7 7> a v 2ETLTWA L XITAIT LET,

Z—PF—r=2 T
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PEZTN 2 —F g H-1

H8H. "SI N a—F 47

Q&A:

Q:
A:

FLVWPC VAT LEMBILTSH EXITCMOS 227 VT TEHHERDHY E35?

TV, L P —R— RE2EETHERIC, CMOS 227 V7352 L2 BED LET,
CMOS V¥ v REFT T /L FD 12 DRI a winb 23 DRy a B L, 23 %L,
ZLTRIELTLES N, YATLAZFLOTRETILEE, 2P —X~v=a T VEDS
R L. Load Optimized Default % FFONAA CTL 72 &1,

BIOS EHHIINY 7T v LT LES7Y HiEo72 CPUNRTFA—FERELTLEST
BARIZIIEI LIeb X WTL X 5 H?

BIOS B DML, CPU /X T A —ZREME VN LDV AT LD T T v 5 L&,
HIZCMOS 7 U 7 &{TH> CTH A FEBSETHATIEEN,

BIOS Wi CA—N—2 0 vy E1-I3EEREOREERAS D &, VAT LEEETEXF, H
EILAHRRENETA, A VR — FRBEELZOTTN? AL R — FERREICRA
FTHMLENRBHY T, X RMA ot X 21T H RE TTH?

—ED BIOS BREZT 7 /v "hInb A== 1 v 7 F 33 FEHREDIRIEICAET L TH,
— R =T FIUTAA A — RB3KARNICHEET 25K & 13720 A, YETiE, ko3
DD RT TN a—T 4 TIZE->T CMOS T—4#%2E L, "—RU=T7DOF 74V E
OWREIZEETE L ICBEO LEST, Zicky, AL R—FRFOHEEL, 22— —
DEWOEDOEIAAL VAR—=REBEWLETFRHEOFREICELEZY . RMA 7t A% FE(TT
LT e 9,

1. BIFEEOERZAZICL, 1 HBRICHRAS AT LET, BENF AR D RVEA.
FBFH T — FE2RONT 1 HBIZELIAALTIIEE WD, F—R— FO<Insert>F — & L 7= F
T, BRACARZCEM L TCUAT AERIILET, EFITEBILES, <nsert>F—%
BEL . <Delete>F—% L TBIOS Y b7 v 7= WA TELWEEZITWET,
INTHRENRI LRWES, AT v 71 23 ERV RSN, 2T v 722 ATL
72EW,

2. BIREEOBFRZA7ICTH0BRa— F2HWT, Yy —Y &£, BhofEc
CCMOS Vv U 3B H D ET, Py L/ WLEET 7 4/ b D 1205 23121 AT L
TCMOS F—ZZMBE L., BOT 74NV MDD 12ICRLET, vy —I 20, Bk
BOEREANCT 20, BRa— F2ELIALET, BFA VAL 2T, VA
FTAEEHLET, EFICREILZS, <Delete>F%—%#L T BIOS v b7 v 72—
VICAST, ELWEEEZITVET, ZATHLRENEEL2WES, 2T v 73 2R
AHATLTEE N,

3. AT v T2 LREILFET, A—rR—Frb ATX B %7 # 2k E . CMOS 25 iE
LTCWDRINZAAL A= FOEMERD AL ET,
TI=ANFR— L LOREREEE ZDITITED Lib XN TTH?

DR =aTIVOEIH D, T7 =AY R— 7 53— LORBNFIHE-> TR L TL
X,

Z—P =2 T



H-2 1187 G

IEICRIBED & 256, DT 7 =Y R— FF— A0 REEZ TP < FFE L CHitl 2
T RARALZANTED LD 77 =¥ R— FIRICIE, MEICBERO RV EDERSRZ A
WP, BEREDEIROLEZFTLA LT EI VN, RRARIE, 77 = R— s bEE
ERonsd & o, WREWMALLZT 4 —7 —EIFMGEEIC Fax LTLZE W (Toflas
LTS |

#l1: ~¥P—mrR—FK (CPU, DRAM, COAST 72 £ &%) . HDD, CD-ROM, FDD, VGA
CARD, VGA #— F, MPEG #— R, SCSI #— R, ¥+ 7> R —RREEETI AT LN
I T 2WGA, LTFOFIBIES TV AT ADFER AV R—FR 2 b aeTF v 7 LTLTE
EV, ROINZ, VGA I — RUSADTRTDA L F T 2—Ah—FERY 4L CHEES LT
<TEEW,

ZRTHEE LARWGE

tO7T Ty RELIFETADVGA I—REA VA M=)V LT, VAT ANBEHFTLINE D
PRLTHATLEZ, TR THEB LARWEAIEX, 77 =0 R— Nk (FheiEs
HEHBM) |2 VGA #— FDOEFNLL, v —R— FDOEF /L4, BIOS @ ID F5. CPU OFE
BHETRAL, “BEOFIMICEEIZ W TOFELWIHAEZIA LT ZE N,

HET 554

BYBRW=A VH T 2= AN —FRE 1 D1 DTICRER LN S, VAT LANES L b %
TUATLADE#ZF =7 LTLIEEY, VGA I — RERBEDRER ot v X7 =
— AN —REERLT, TOMOH— FE I OEDEMRERY AL T, AT A2 FHOWEH) L
TS, ZRTHERE) LARWEA, "2OMO T — R "OMIZ 2 #d — RIZBE T 2
FRALTLEEN, B, v~ F—KR—RKDOET L4, /S—Y 3>, BIOS ®ID %%, CPU
O (EREEFHEEBR) | BLOEZMEICOWTOHE LW ZILAT D EENLLR N
TLEE W,

fl2: ~<~H¥—A—F (CPU, DRAM, COAST 7 ¥ % &%) . HDD, CD-ROM, FDD, VGA
H— R, LAN #— F, MPEG 7 — R, SCSI 1 — K, 7> Rh— R EE2EH Y AT LT,
YU RI—RDORTANDA LA N—)V, VAT LEFHEBLZY, YU FI— KD
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CONFIG.SYS:

DEVICE=C:\DOS\HIMEM.SYS
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FILES=40

BUFFERS=36

REM DEVICEHIGH=C:\PLUGPLAY\DWCFGMG.SYS
LASTDRIVE=Z
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% : REV: 1.00

3. BIOSID BEIHAEE : AL A7 V=0 DA =V TELES D,

CD-Title Rev. No.
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ANRDT 4 27 (b LbiL) I
[Release *.**7] 72 L LFLIN TN D

W= g VFSZEFTVALET,

LT ], I Device Drives
i

Drivers Diskette Brlease 1G04
K

Floppy Disk Driver Rev.No.

508 BLOV AT ATRE LTV
AT FVr—a B ALET,
i : MS-DOS® 6.22, Windows® 95, Windows"™ NT....

. CPU: CPU DA =D —ZBIOEE (MHz) 2FALET,
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